
Προετοιμασία εικόνας. Για χρήση στο 

internet 

by atelier.photo in Know How, Επεξεργασία εικόνας 

 

Η προετοιμασία μιας ψηφιακής φωτογραφίας για χρήση στο internet είναι 

ίσως από τα πιο παραμελημένα στάδια της ψηφιακής επεξεργασίας 

εικόνας. Αποτελεί όμως στάδιο αρκετά σημαντικό εφόσον σε αυτό 

παράγεται το τελικό αποτέλεσμα που παρουσιάζεται σε πάρα πολλούς 

θεατές. Τα “υψηλής ανάλυσης” αρχεία δε θα τα δει ποτέ κανείς γιατί αυτά 

μένουν στον σκληρό δίσκο ή προορίζονται για εκτύπωση. Θα ήταν λοιπόν 

κρίμα να έχουμε δώσει τον καλύτερο εαυτό μας στη δημιουργία της 

ιδανικής εικόνας με την τέλεια οξύτητα και να αδιαφορήσουμε για το 

τελευταίο βήμα. Θα ήταν σαν να είχαμε μια πολύ ακριβή φωτογραφική 

μηχανή, μ’ έναν πολύ αξιόλογο φακό και τελικά να βάζαμε μπροστά ένα 

πολύ φθηνό φίλτρο. 

  

Η πρόκληση 
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Τα πράγματα όμως δεν είναι τόσο απλά. Εμείς ως δημιουργοί καλούμαστε να 

δώσουμε τη βέλτιστη ποιότητα, όμως ελλοχεύουν κίνδυνοι. Η αυξημένη 

ταχύτητα του internet και η βελτίωση του browsing έχουν δημιουργήσει 

υπερβολικές προσδοκίες ποιότητας απεικόνισης για το φωτογραφικό υλικό 

στις οποίες αν ανταποκριθούμε, το υλικό μας μπαίνει σε κίνδυνο να πέσει σε 

κακά χέρια. Θα πρέπει λοιπόν να συγκεράσουμε τους αντιφατικούς 

παράγοντες: η ποιότητα να είναι επαρκής και ελκυστική για απεικόνιση στο 

internet αλλά όχι τόσο κατάλληλη για άλλες χρήσεις όπως η εκτύπωση, 

αποτρέποντας έτσι την πιθανή κλοπή και άλλη κακόβουλη ή κερδοσκοπική 

χρήση των έργων μας από τρίτους. 

Στο σημείο αυτό, καλό είναι να καταρριφθεί ο μύθος περί κλειδώματος και 

παρακολούθησης (tracking) των αρχείων μας στο internet. Δεν υπάρχει καμία 

μέθοδος ολοκληρωτικής προστασίας, υπάρχουν μόνο τρόποι που 

δυσκολεύουν το χρήστη από το να αντιγράψει μία εικόνα: Κλείδωμα του δεξιού 

κλικ του ποντικιού για να μη γίνει αποθήκευση, προσθήκη διάφανων layers 

πάνω από αυτήν, κλείδωμα του drag and drop και άλλα.  Από τη στιγμή όμως 

που η εικόνα έχει εμφανιστεί στην οθόνη ενός υπολογιστή, tablet ή κινητού 

τηλεφώνου, τότε υπάρχει και η δυνατότητα αποθήκευσης αυτής με τον ένα ή 

τον άλλο τρόπο, με έσχατη λύση το print screen. 

Η υπογραφή 

Ανάμεσα στις αποτελεσματικές λύσεις για την αποφυγή κακόβουλης χρήσης 

είναι ο δημιουργός να “υπογράψει” το έργο του. Εκεί πάλι υπάρχουν δυο 

δρόμοι: ο πρώτος είναι να προσθέσει ένα ημιδιάφανο υδατογράφημα και να 

καταστήσει εξαιρετικά δύσκολη την αφαίρεσή του εφόσον απαιτεί πάρα πολύ 

καλή χρήση του Photoshop και αρκετό χρόνο. Όμως σε αυτή την περίπτωση 

εκτός από τους “κλέφτες” ενοχλούνται και οι θαυμαστές αφού ένα τέτοιο 

υδατογράφημα στη μέση του έργου αφαιρεί μέρος της ομορφιάς και της 

ατμόσφαιράς του. Η δεύτερη επιλογή είναι το έργο να υπογραφεί πολύ 

διακριτικά σε μία γωνία ή σε ένα καθαρό σημείο έτσι ώστε να αποτελεί 

πραγματικά υπογραφή και όχι μέρος της εικόνας. 

Η υπογραφή ενώ εύκολα είτε θα σβηστεί είτε θα κοπεί, είναι τόσο διακριτική 

που έχει πολλές πιθανότητες να ”γλιτώσει” γιατί δεν ενοχλεί κανέναν. Έτσι σε 

ένα share θα επιβιώσει μαζί με την πληροφορία που θέλουμε να διαδοθεί. Θα 

έπρεπε να λαμβάνουμε υπόψη μας ότι λόγω του μικρού μεγέθους της εικόνας 



που θα χρησιμοποιηθεί τελικά, υπάρχει περίπτωση να μην διαβάζεται η 

υπογραφή οπότε θα πρέπει να είναι ειδικά μελετημένη. 

Το μέγεθος 

 

Η μείωση των pixel της εικόνας είναι το πιο σημαντικό βήμα. Τα συνολικά pixel 

και μόνο αυτά (όχι η ανάλυση) καθορίζουν πόσο μεγάλη και καθαρή θα 

εκτυπωθεί μία εικόνα. Για παράδειγμα μία εικόνα 800×533 pixel μπορεί να 

εκτυπωθεί καθαρά σε πλάτος το πολύ ως 8εκ. σε μία σελίδα, πράγμα που την 

καθιστά σχεδόν άχρηστη για έντυπη χρήση. Να διευκρινήσουμε (επειδή πολλές 

οι φωτογράφοι έχουν συγκεχυμένη αντίληψη του θέματος) ότι αν ένα αρχείο 

800×533 pixel έχει ανάλυση 300dpi ή 72dpi ή σε ακραία εκδοχή 1dpi η ακόμα 

και 1000dpi, αυτό δεν παίζει ρόλο για την ευκρίνεια της εκτύηωσης. Αν 

υπάρχουν αρκετά pixel τότε θα τυπωθεί σωστά. Εδώ λοιπόν εκμεταλλευόμαστε 

το γεγονός ότι η οθόνη δεν απαιτεί τόσα pixel όσα το χαρτί. Όμως στις μέρες 

μας οι οθόνες υψηλής ευκρίνειας (HD, 4K, Retina κλπ.) απαιτούν ολοένα και 

περισσότερη ανάλυση. Σε αυτή τη λογική ακόμα και ένα smartphone μπορεί να 

απαιτεί ανάλυση (μεγάλης πλευράς) άνω από 2000 pixel πράγμα που 

μεταφράζεται σχεδόν σε μέγεθος A4 εκτυπωμένο. Συνηθισμένα μεγέθη εικόνων 

για χρήση στο internet πάντως είναι από 700 έως και 1200 pixel για τη μεγάλη 

πλευρά. 
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1. 

Για να πετύχουμε όλα τα παραπάνω στο Photoshop, ανοίγουμε την εν λόγω 

εικόνα και επιλέγουμε τη λειτουργία Image Size (Ctrl/Cmd + Alt + I) από το 

μενού Image. Εκεί στο Dimensions αλλάζουμε την τιμή των pixel της μεγάλης 

διάστασης. Η μικρή διάσταση συμπληρώνεται μόνη της εφόσον είναι 

ενεργοποιημένο το αλυσιδάκι ανάμεσα στις δύο τιμές. Να αναφέρουμε ότι για 

τους χρήστες της έκδοσης CS6 και πίσω ότι το παράθυρο Image Size έχει 

αρκετές αλλαγές στην εμφάνιση αλλά όλες οι λειτουργίες εξακολουθούν να 

υπάρχουν. 

Η οξύτητα 

2. 

 

Κάθε εικόνα που υπόκειται αλλαγή του αριθμού τον pixel (interpolation) έχει 

την ανάγκη για ρύθμιση της οξύτητάς της. Μόλις από το παράθυρο Image Size 

διακρίνουμε τη λειτουργία Resample που ορίζει τον κατάλληλο αλγόριθμο για 

την οξύτητα της εικόνας. Εκεί από προεπιλογή υπάρχει ο Automatic. Αυτός 

πολύ σωστά όταν αναγνωρίζει μείωση των pixel από μόνος του επιλέγει τον 

αλγόριθμο “Bicubic Sharper (reduction)”, ο οποίος μας προτείνει όξυνση. Αν και 
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σωστή η λογική της επιλογής, ο συγκεκριμένος αλγόριθμος λειτουργεί λίγο 

υπερβολικά οπότε θα προτιμήσουμε έναν ουδέτερο έτσι ώστε να βάλουμε σε 

δεύτερο βήμα όση οξύτητα απαιτείται. Άρα στην λειτουργία Resample τελικά 

επιλέγουμε “Bicubic (Smooth Gradients)” και πατάμε ΟΚ. 

3. 

 

Για να ρυθμίσουμε τελικά την οξύτητα του μικρού πλέον αρχείου πάμε στο 

μενού Filters → Sharpen → Unsharp Μask. Στο παράθυρο που εμφανίζεται, οι 

τιμές της ποσότητας (Amount) και της ακτίνας (Radius) θα πρέπει να 

κυμανθούν ανάμεσα στις τιμές 20-60% και 0,2-0,5 pixel αντίστοιχα, ενώ το 

Threshold θα παραμένει στο μηδέν. Να σημειωθεί ότι η επεξεργασία αυτή δεν 

αφορά στη διόρθωση μίας θολής φωτογραφίας, αλλά στην τελειοποίηση μίας 

ήδη καθαρής και μειωμένου μεγέθους εικόνας. 

4. 
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Αν ο φωτογράφος υπερβεί τις ενδεικτικές τιμές, τότε το μόνο που θα 

καταφέρει είναι η αλλοίωση της εικόνας, η δημιουργία ψηφιακών λαθών 

(artifacts) και η εσφαλμένη αντίθεση και χρώμα. Χαρακτηριστικά φαίνονται 

στην εικόνα, έπειτα από υπερβολή για χάρη του παραδείγματος, το λευκό 

στεφάνι γύρω από τα μαλλιά και το ρούχο αλλά και το άγριο δέρμα και 

αντίθεση. Θα μπορούσε κάποιος να ξεγελαστεί και να μη δει το μικρό λάθος η 

ακόμα και να του αρέσει το αποτέλεσμα των καινούριων τόνων, όμως δε θα 

πρέπει να μπερδευτεί, η επεξεργασία σε αυτό το στάδιο δεν είναι τονική. Αν για 

οποιοδήποτε λόγο ο δημιουργός θέλει να κρατήσει τα νέα χρώματα, τότε 

οφείλει να το κάνει πριν το Image Size με άλλο τρόπο και στη συνέχεια να 

ακολουθήσει την τεχνική του άρθρου. 

Η ροή εργασίας 

Μείωση του μεγέθους → Όξυνση φωτογραφίας → Προσθήκη 

υπογραφής → Αποθήκευση στο κατάλληλο φορμά. 

 Η αποθήκευση 

5. 
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Τρίτο και τελευταίο βήμα αυτής της τεχνικής είναι η συμπίεση και αποθήκευση 

που ολοκληρώνεται με την επιλογή από το μενού File → Export → Save for Web 

(Legacy). Το μενού αυτό έχει μετακινηθεί από στις τελευταιες εκδόσεις από τη 

θέση  File → Save for Web αλλά σε κάθε περίπτωση καλείται με τη συντόμευση 

Ctrl/Cmd + Alt + Shift + S. 

Tips 

•     Για να οριστεί ως προεπιλογή στο Image Size ο αλγόριθμος “Bicubic 

(Smooth Gradients)” αρκεί να πάμε στις ρυθμίσεις του προγράμματος από το 

μενού Edit →  Preferences (για Windows) ή Photoshop →  Preferences (για OSX). 

Εκεί στην καρτέλα General το διαλέγουμε κάτω από την επιλογή Image 

Interpolation. (Ctrl/Cmd + K) 

•     Επειδή η διαδικασία που περιγράφουμε πάνω είναι αρκετά τεχνική και δεν 

έχει δημιουργικές αποφάσεις, όταν καταλήξουμε στα μεγέθη που μας βολεύουν 
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μπορούμε να δημιουργήσουμε ένα Action που με το πάτημα ενός κουμπιού θα 

κάνει Resize → Sharpness → Save → Close. 

 

6. 

Στο νέο παράθυρο που εμφανίζεται επιλέγουμε αρχείο JPEG ποιότητας από 

93% έως 98%. Χαμηλότερες ποιότητες, δηλαδή υψηλότερες συμπιέσεις, 

προκαλούν τα λεγόμενα JPEG artifacts τα οποία αρχίζουν πρώτα να γίνονται 

ορατά σε ομοιόμορφες επιφάνειες της εικόνας. Καλό θα είναι εφόσον πρόκειται 

για φωτογραφική δουλειά, να μη θυσιαστεί άλλο η ποιότητα μόνο για το 

κέρδος μερικών kilobytes που ειδικά στη σύγχρονη εποχή, δεν αποτελούν 

κανένα πρόβλημα. Προαιρετικά μπορούμε να επιλέξουμε τον τύπο Progressive 

αλλά υποχρεωτικά πρέπει να επιλέξουμε τη λειτουργία “Convert to sRGB” μιας 

και το internet χρησιμοποιεί αυτό τον χρωματικό χώρο. 

7. 
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Ένας από τους δημοφιλέστερους προορισμούς των αρχείων μας είναι το 

Facebook. Το τελευταίο, όντας η μεγαλύτερη ιστοσελίδα με τις περισσότερες 

φωτογραφίες στον κόσμο, για να ελαττώσει το γιγάντιο μέγεθος του 

αποθηκευτικού χώρου που χρειάζεται, μικραίνει και ανασυμπιέζει τις εικόνες 

των χρηστών, πράγμα ιδιαιτέρως καταστροφικό. Ευτυχώς για εμάς, έπειτα από 

παράκληση πολλών επαγγελματιών, δόθηκε η επιλογή της χρήσης του φορμά 

PNG το οποίο παρόλο που είναι λίγο μεγαλύτερο σε kilobytes, το Facebook δεν 

το συμπιέζει περαιτέρω και έτσι οι εικόνες μας μένουν ανέπαφες. Να σημειωθεί 

ότι αυτό απαιτεί ανέβασμα σε Facebook page και όχι Facebook profile ή 

προσωπικό μήνυμα. Η επιλογή αυτή υπάρχει στο παράθυρο Save for Web, ως 

PNG-24. 
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Do’s • Sharpness • Προσοχή στο Resample • Λίγα pixel • Save for Web • JPEG / 
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Foto format 

Στο άρθρο αυτό παρουσιάζονται οι τύποι αρχείων (file’s formats) που χρησιμοποιούνται 

περισσότερο στην αποθήκευση εικόνων. Κάθε τύπος αρχείου έχει μοναδικά χαρακτηριστικά 

και δημιουργήθηκε με σκοπό να χρησιμοποιηθεί σε συγκεκριμένες εφαρμογές και με 

συγκεκριμένο τρόπο. 

Όλοι οι τύποι δεν κάνουν για όλες τις χρήσεις. Για παράδειγμα, είναι λάθος να 

χρησιμοποιούνται εικόνες από το internet (GIF, PNG, JPG) για την δημιουργία εντύπων και 

αντίστοιχα δεν γίνεται να ανεβούν σε μία ιστοσελίδα εικόνες τύπου TIF ή PSD. Στη συνέχεια 

αναλύεται ο κάθε τύπος και τα αντίστοιχα τεχνικά χαρακτηριστικά. 

 

.JPG (Joint Photographic Experts Group) 

Πρόκειται για μια συμπιεσμένη μορφή αρχείων, που χρησιμεύει για την μετατροπή εικόνων σε 

χαμηλή ανάλυση και την προβολή τους μέσω internet και ψηφιακών φωτογραφικών μηχανών. 

Η εικόνα κατά τη συμπίεση μικραίνει ως προς το μέγεθος του αρχείου, χάνοντας ταυτόχρονα 

ένα ποσοστό από την ποιότητά της, αλλά η προβολή της παραμένει (ανάλογα με το ποσοστό 

συμπίεσης) αναλλοίωτη. Αυτό συμβαίνει γιατί ο συγκεκριμένος αλγόριθμος συμπίεσης 

απορρίπτει τις πληροφορίες μιας εικόνας που αδυνατεί να καταλάβει το ανθρώπινο μάτι. 

Το ποσοστό συμπίεσης είναι ελεγχόμενο, κατά τη δημιουργία του αρχείου, από ένα πεδίο που 

λέγεται JPG Quality. Η συμπίεση και η ανάλυση λειτουργούν ως δυο τιμές αντιστρόφως 

ανάλογες. Δηλαδή, όσο μικρότερο γίνεται το ποσοστό της συμπίεσης τόσο υψηλότερη 

παραμένει η ανάλυση και αντίστοιχα όσο αυξάνεται η συμπίεση τόσο χαμηλότερη γίνεται η 

ανάλυση άρα και η ποιότητα της εικόνας καθώς και το μέγεθος του αρχείου. 

Το format JPG χρησιμοποιείται κυρίως σε περιπτώσεις που το μικρό μέγεθος αρχείου είναι 

σημαντικότερο από την ποιότητα της εικόνας. Τέτοιες περιπτώσεις είναι η προβολή εικόνων 

μέσω internet, emails, memory cards ή η χρήση εικόνων σε παρουσιάσεις μέσω projectors ή 

video walls κ.λπ. Επειδή κάθε φορά που μια εικόνα μετατρέπεται σε JPG αρχείο, εξαιτίας της 

συμπίεσης, χάνει ένα μέρος της πληροφορίας της, καλό είναι να αποφεύγεται η 

επαναλαμβανόμενη αποθήκευση στο format αυτό. Λόγω της χαμηλής τους ποιότητας, οι 

εικόνες με JPG format δεν χρησιμοποιούνται σε εφαρμογές που προορίζονται για εκτύπωση 

offset. Δεν υποστηρίζει διαφάνεια στο φόντο της εικόνας. 

  

.PNG (Portable Network Graphics) 

Τo format αυτό δημιουργήθηκε αποκλειστικά για την προβολή εικόνων μέσω internet. 

Υποστηρίζει από 1-bit έως 48 bit βάθος χρώματος, τις χρωματικές παλέτες RGB και INDEX, τη 

διαφάνεια στο φόντο του σχεδίου και είναι το καλύτερο για την προβολή κειμένου και 

γραφικών online. Δεν συνίσταται η μεταβολή του μεγέθους του μετά την δημιουργία του 

αρχείου. 

 

.GIF (Graphics Interchange Format) 

Αυτός ο τύπος αρχείου εικόνας δημιουργήθηκε από την CompuServe πριν τον τύπο JPG, για να 



υποστηρίξει την μετάδοση 8-bit video μέσω συνδέσεων dial up modems. Όμως ακόμα και 

σήμερα είναι ένας τύπος αρχείου που χρησιμοποιείται μέσω internet. Μπορεί να αναπαράγει 

μέχρι 256 χρώματα και παρέχει τη δυνατότητα animation. Επιπλέον, επιτρέπει τη συμπίεση 

των αρχείων και υποστηρίζει τη διαφάνεια στο φόντο του σχεδίου. 

  

.PSD (Adobe Photoshop Format) 

Αυτό ο τύπος αρχείου αφορά αποκλειστικά τους χρήστες της εφαρμογής Adobe Photoshop. Τα 

αρχεία φωτογραφίας με αυτό το format παράγονται από την συγκεκριμένη εφαρμογή. Το 

άνοιγμα των αρχείων αυτών γίνεται από Photoshop συγκεκριμένης version ή νεώτερης όχι 

όμως από μια παλαιότερη. Υποστηρίζει από 1-bit έως 48 bit βάθος χρώματος, τις χρωματικές 

παλέτες RGB, CMYK, LAB, INDEX κ.ά. και αναλύσεις όπως 72dpi, 150dpi, 300dpi, 600dpi ή 

1200dpi. Μέσα στα αρχεία αυτά αποθηκεύονται εικόνες που αποτελούνται από μάσκες, 

φίλτρα, layers, διαφάνεια, κείμενο, actions κ.λπ. Αυτός ο τύπος αρχείου δεν χρησιμοποιείται 

σε εφαρμογές μέσω internet. 

  

.TIF (Tagged Image File Format) 

Το format ΤΙF υποστηρίζει την υψηλή ποιότητα των φωτογραφιών και μάλιστα χωρίς 

απώλειες. Συμπεριλαμβάνει ως επιλογή τη συμπίεση LZW, η οποία θεωρείται η υψηλότερη 

μορφή στην ποιότητα των εικόνων. Το format ΤΙF χρησιμοποιείται σε πολλές εφαρμογές εκτός 

από το internet. Υποστηρίζει από 1-bit σε 48 bit βάθος χρώματος, τις χρωματικές παλέτες 

RGB, CMYK, LAB, INDEX κ.ά. και υψηλές αναλύσεις όπως 150dpi, 300dpi, 600dpi ή 1200dpi. 

Μέσα στα αρχεία αυτά αποθηκεύονται εικόνες που αποτελούνται από μάσκες, Alpha channels, 

φίλτρα, layers, κείμενο κ.λπ. Είναι ο τύπος φωτογραφιών που χρησιμοποιείται κυρίως σε 

έντυπα που πρόκειται να εκτυπωθούν με την offset ή με την ψηφιακή μέθοδο. 

  

.RAW (Raw Image File) 

Οι εικόνες τύπου .RAW δημιουργούνται από τις περισσότερες ψηφιακές φωτογραφικές 

μηχανές, κυρίως τα μοντέλα DSLR. Στις περισσότερες από αυτές τις μηχανές υπάρχει επιλογή 

για παραγωγή των εικόνων σε RAW ή JPG. Είναι ένας τύπος αρχείου που ανταποκρίνεται 

αποκλειστικά στις τεχνικές προδιαγραφές κάθε φωτογραφικής μηχανής. Τα RAW αρχεία δεν 

χρησιμοποιούνται τα ίδια σε καμία εφαρμογή. Μέσω ειδικού software, που πολλές φορές και 

αυτό εξαρτάται από την κατασκευάστρια ή κάποια άλλη εταιρία, μπορεί να γίνει το αρχικό 

στάδιο επεξεργασίας της εικόνας και στη συνέχεια γίνεται μετατροπή σε αρχεία JPG ή TIF 

ανάλογα τη χρήση για την οποία προορίζονται. 

Κατά το αρχικό στάδιο επεξεργασίας ο τύπος RAW επιτρέπει τη ρύθμιση στη φωτεινότητα και 

το χρώμα. Επίσης, δίνει τη δυνατότητα να ολοκληρωθούν οι ρυθμίσεις στην ισορροπία λευκού 

ακόμα και αν έχει ολοκληρωθεί το τελικό αποτέλεσμα. Το αρχείο RAW 12-bit προσφέρει 

μεγαλύτερο εύρος για οποιαδήποτε από τις ρυθμίσεις, συχνά σε πολλαπλά αρχεία 

ταυτόχρονα. Διατηρεί πάντα άθικτη την αρχική έκδοση, ώστε να υπάρχει πάντα η δυνατότητα 

δημιουργίας αντιγράφων με διαφορετικές ρυθμίσεις. Πολλές φορές τα αρχεία αυτά λέγονται 

και Digital Negatives, επειδή δεν μπορούν να χρησιμοποιηθούν αυτούσια σε κάποια 

εφαρμογή, αλλά περιέχουν όλες τις πληροφορίες που χρειάζονται ώστε να δημιουργηθούν 



από αυτά εικόνες σε άλλα εύχρηστα formats. Με αυτή τη λογική λειτουργούσαν και τα 

αρνητικά films των παλαιότερων αναλογικών φωτογραφιών. 

  

.BMP (Bitmap Image File) 

Ένας τύπος αρχείου που χρησιμοποιούνταν περισσότερο στο παρελθόν για να αποθηκεύει 

ψηφιακές εικόνες, οι οποίες εξαρτιόνταν από τις τεχνικές προδιαγραφές της κάρτας γραφικών 

και του λειτουργικού συστήματος, κυρίως των Microsoft Windows και OS/2. Οι εικόνες που 

δημιουργούνταν με βάση αυτόν τον τύπο μπορούσε να είναι οποιουδήποτε μεγέθους, 

ανάλυσης ή χρωματικής παλέτας, αλλά η ασυμπίεστη ουσιαστικά μορφή τους δημιουργούσε 

πολύ μεγάλα και δύσχρηστα αρχεία. 

  

Τέλος, πρέπει να αναφερθεί ότι όλοι αυτοί οι τύποι αρχείων είναι εύκολο να τους βρείτε και 

να τους επιλέξετε. Συνήθως βρίσκονται στο menu του πεδίου File Type (ή Format), στο 

παράθυρο που εμφανίζεται από την επιλογή Save as. Έτσι μπορείτε να μετατρέψετε τις εικόνες 

σας από τον έναν τύπο στον άλλον. 


